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Installation Instructions and Cautions

PLEASE NOTE: MAS 90 must already be installed on your
system before installing any 11G enhancement. If not already
done, perform your MAS 90 installation and setup now; then
allow any updating to be accomplished automatically.

Once MAS 90 installation and file updating is complete, you may
install your 11G enhancement product by following the procedure

below.
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Introduction

The RF Warehouse Automation enhancement for MAS
90 isthe tool you need to serve your customers more
effectively. Your team will be able to enter sales orders,
shipping data and receipts of goods while on the road with
their Radio Frequency device with Windows CE — saving
time and ensuring accuracy.

By connecting sal espeople who are in remote locations to
MAS 90 software, your company will bein a strategic
position to serve your customers more quickly and more
efficiently.

If you have salespeople who are traveling, Radio Frequency
solutions can be a valuable addition to your company.
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Before you run RFS

Before you start using RF Warehouse Automation, you
must modify its desktop shortcut to be ableto runiit.

Map the Network drive where your MAS90 system is
located.

Right-click the RFS icon on the desktop, and select the
Properties in the pop-up menu. Go to the Shortcut tab.

In the Target field, type
your path\M A S90\Home\pvxwin32.exe -hd ..\launcher\sota.ini
.\s0a\RFS_Startup.mdp

(where your path stays for the path to your MAS 90/200 system, e.g.
D:\MAS\Mas420\Rfs).

Type the path to the MAS 90 system using mapped drive.
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RF5 440 MAS 90 Properties

General Shortcut |Eu:um|:uati|:|ilit_l,l| Securit_l,ll

I@ RF5 440 MAS 90

d

T arget type: Application

T arget location: Home

Target: cherhaota.ini b FFS startup. md ot S RN

Start in: Iu:l:"-.M.-’-'-.S " azd4DNRFSAMAS A0 Home

Shortout ke INn:-ne

Bur: I Marmal window

-

Comment; I

Eind T arget... | LChange |con... Bdvanced... |

k. I Cancel

Apply

Click Ok or Apply to save this change.
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RF Client Configuration for MAS200

To be able to run RF in the client server modeitis
necessary to copy the filesfrom RFS_Workstation folder
to your Workstation (Client) MAS90 folder. After
copying the filesit is necessary to create rfs_sota.ini filein
the: Client\MAS90\Launcher. It isacopy of original
sota.ini except that APPLICATION=MAS 200 RFS (this
is areference to a application in the application server).
New Application called MAS 200 RFS should be added
into the Application Server Configuration. It isacopy of
MAS 200 application with the following changes:

Application Name: Mas 200 RFS
Lead Program: rfs_startup.m4p

= Application Server Configuration

Eile Help

Semver | SAGE ﬂ Status: | Stopped

Sezsions ] Server ] Clients ] Apps ] [zers ] Service ] Laaging ]

=101 %]

| ||

Type | Deny | Application Mame | Command Line e
L [T maAs 200 carg(0)x -hd "Startl)p M 4P
L [ A5 200 Link <arg[0) -hd "5Y_ProcessURL M4P"

W | Mas 200 FFS cargl0)> -hd "RFS_StartUp, M4P"

|:| Ihchude Global Apps

[ Details ][ New ][ Delete ]

[ Apply H E it ]

INFORMATION INTEGRATION GROUP
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x|

—iypplication —Option
&pp Name: | [TEERETIIES

|:| Dizable Application
Allowe Client Extra CMD Options
Allawy Client Arguments

Provide EXE: | <Default:

Server [MI: | <Default:

|:| Allow Client to Set Start-ln Directory

Eutra CMD Options: |

—05 Level

Default Umazk: Q000

|:| Detach Spawns wia Hohup

|
|
|
Lead Program: | RFS_Startp b4P | Allow Client to Set FID
|
|

Arguments: |

Start-lr Directon: | <Defaulty |

It oy |N':'"T'E'I ﬂ| Additional Erveironment ' ars:
—Llignt il
Client Type: | Any Clisrt Type ||
Wind< Ver | 0.00.0000400 | Max wind<Yer | 0.00.0000/00 LI

Jave Wer | 0.00.0000/00 b & J v Wer: | 000000000

aF. ] [ Cancel l
The following changes should be done in the MAS200
shortcut to launch RF:
INFORMATION INTEGRATION GROUP 877.475.4092
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MAS 200 4.40 RF Properties ed |

General Sharteut | I:::umpatil:uilit_l,ll Seu:urit_l,ll

MAS 200 4.40 RF

T arget bype:

T arget location: Home

werMamer'" "'10000" "rMAS 200 BFS

Target: launcherdifz_sota.ini “fz_Client -4RG "'Se

Start in: I-:I: W azh a2 004 a=4408RF S elhent MASA0NHC

Shortcut ke INn:nne

Bur: I Marmal window j

Comment; I

Eind Target... | Change [con... Advanced... |

] I Cancel Apply

The path of you client system is entered in the Start in
field. Therfs_sota.ini and *rfs_Client are added in the
Target field.
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Registering IIG products

I1G Enhancement should be registered to be able to useit.
If registration is not performed, the enhancement will work
in ademo mode for alimited time period. The registration
can be still done during the demo period.

Select the 11G Product Registration program under the
Library Master Setup menu of the MAS 90.

If thisoption is not listed under the Library Master Setup
menu, go to the main menu, and select Run from the File
menu. Typein SVIIGR and click OK.

EIpR=E
Feqistered Customer G
~Reaigtration [nformation
Reseller Mame
Senial Mumber 1111111
Cuztomer Mumnber 22L2222A2
Uszer ey 333IFA333333333333
Product Key L] ] 25505 55a5h L]
E nhancement Level Feleaze Date  Sernial Mumber Unlocking k.ey
IIG Enhancement Hame 440 ALARALLADISS | [BEEEEE

Senial Number

Ernhancement Releaze Date

al | i

[ Frint Reaqistration Farm l

| | s | aBx | 3A0/200

Enter Serial Number and Unlocking Key provided by I1G,
and click OK.

If multiple I1G Enhancements are installed, Serial Numbers
and Unlocking Keys should be entered for each
enhancement.

I1G Registration Form can be printed by using the Print
Registration Form button.

INFORMATION INTEGRATION GROUP 877.475.4092
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MAS 90 for Windows CE Launcher

Note: The RF Warehouse Automation security event must
be enabled in the Role Maintenance for the role assigned to
the user in order to allow running MAS 90 for Windows
CE.

ﬂi Role Maintenance (ABC) D6,/22 /2011 _ ||:|| El

Role admin R VP NN

Dezcnption | administrator

1 Tasks ] 2 Security Events | 3 Mu:u:luleElptiu:uns] 4 ODBC Seu:urit_l,l]

¥ Allow User to Access Menu \wizard ﬂ
¥ Allow User to LockAdnlock Uzers in Uszer Maintenance

¥ Allow Users to Terminate Tazks in Master Conzole [MAS 200 only]

v Enable File Run

¥ Full Access to Private Reports for All Modules

¥ Full Access to Read Only Reports for All Modules

=1 BF " arehouse Automation

bl atenial Requirementz Flanning

Faperlezs Office

Fayroll

Purchase Order

Report b aster

Return Merchandize Authonzation j

HEERBB
4R R R R R

[ Accept I Cancel I Delste I&l@l .

When running MAS 90 for Windows CE, the first screen
you see isthe User Logon screen:

2

R -
1

Enter your uger lagon name and pazsword,
Logon |

Pazszword

| ok | cancel |3

Enter your user logon and password.

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
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Then select the Company:

2]

w
o

Select the company vou want to access.

Comparny %

ABC Diztribution and Service Carp.

N 6)

The launcher is opened:

2] i)

3 Shipping D ata Entry

=) Receipt of Goods Enty

3 lrvventary Tranzaction Enkmy
% Physical Count Enty

I Shut Diowry l

The MAS 90 for Win CE launcher enables you to work
with Shipping Data, Receipts of Goods, Inventory
Transaction (Transfer and Adjustment) and Physical
Count.

To launch any of these options, select it and click the
Proceed button, or simply double-click the option you
want.

Y ou can aso change the active Company, Date, and User
clicking the icons below.

INFORMATION INTEGRATION GROUP 877.475.4092
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EIPRI=IES

Select the compary pou want to access.

Comparny %

ABC Diztribution and Service Caorp.

Lo e O]

2

E
3
Enter the accounting date for

Purchaze Order.

Lo e [0

The Shut Down button closes MAS 90 for Windows CE.

INFORMATION INTEGRATION GROUP
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Shipping Data Entry

If Batch Entry is allowed in the Sales Order Options, the
S/O Shipping Batch screen is displayed before opening the
Shipping Data Entry screen.

(5 5,/0 5,0 Shipping E 10| x|
BatchMo| 00001 " [ 14 4 b B
Comment | Frivate Batch [_]

[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]
Statuz | Available | C. By
Entrigz 0 k. By

[ Accept I LCancel I Delete IG]

Click the Next Batch Number button to start a new batch,
or enter an existing batch number.

In this case, the batch number is displayed on the Shipping
Data Entry, and can be changed using the Batch Number
button.

INFORMATION INTEGRATION GROUP
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D1 | &P 230201150 Q
Shp oooo1 |

| Batch Number, 4B

R | 17 -
VB Pkg E
[tern Code |Drdered|5hipped| Back |

1| | H|
o ] =B CEEER)

The Shipping Data Entry screen enables you to enter
shipping data.

{5 Shipping Data En

A

A o ] 3
ID 1 |/ 08/23/20 70 0000174 |G S

Shp 0100058 | Mew 0ooon |- NG \
01-AWHET Aynet Proceszzing Corp

Q g 1B - Shipper ID, Date, Order No, Lookups

S & £, Pka| 0001 |2 4|
|tem Code Drdered|5hipped| Back |
1001-HONH252 | 500 0 .00F .00 Hi

1001-HOW-H254L  2.00 aa .00 Hi
BER0-2E6-16-11 E.00 aa 00 5i

4 | H|
| O |é Adne [ @

S/ID is Shipper ID.

Is Clear. Next to it isthe Order No.
First Lookup displays the Sales Order List, to ship the
selected Order. Second lists already entered Shipments.
Shp. isthe Shipping Number and Status.

INFORMATION INTEGRATION GROUP 877.475.4092
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2l-icix
ID[1 || 06/23/207 [ooomi74 (@ %

She 0100058 | New 00001~ IIG

01-2HET Aynet Proceszsing Corp
Qa v . q % =
= & =, Pka| 0001 | ()
Itemd Itern Packaging, Alt-G E.j| Back |

1001-HOM-H252 [ 500 500 .00 Hi
1001 HOM-H2541f 200 200 .00 Hi

BES0-26-16-11 EOD . EOD: .00 SI

1| | H|

Click the Item Packaging (Alt-G) button to open the Item
Packaging Maintenance.

I [=TE
Packane , - % 4 4 & R
@5 -

[tern on Order  [antity an Elljan::k#ity in F'a{
00 [« 500

1007-HOMN-H254L 200 [V 200
BE50-26-16-11 600 [ 600

Accept l Cancel ] Delzte [ﬁ]

INFORMATION INTEGRATION GROUP
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Fapl=TE

ID| 1 |/ 08/23/20 70 | ooooiT4 (G S

Shp 0100059 | Mew ooooz |\ <G
01-AWHET Avnet Proceszsing Corp

Q@_EL 1%7
&1 & £, Pka|0002 [ |

—l Mewt Package Mo, Al iihipped| Back |

1001-HOW-H252 | 5.00 .00 .00 Hi
1007-HOW-H254L  2.00 aa 00 Hi
BE650-26-16-11 £.00 aa 00 5i

“| | H|
| u ||5 Adne [ E]

Y ou can create the Next Package by the help of Next

Package No. button.

2 1o x]
D 1 |~ 08/23/20T7 ooooiTd |G S
Shp 0100063 | New oooot | NG

01-AWHET Aynet Proceszing Corp

% o 4 % >
S5 reon B EID
ltem | Lot/Serial Distribution, & bak ]
1001-HOMH2S4 200 00 .00
BESO-26-1611 | GO0 .00 .00
2551-350 3.00

l |
o Ié Adlne[v]

The Lot/Serial Distribution button is enabled for

Lot/Seria lines.

The Lot/Serial Distribution screen is opened
automatically upon entering the Shipped Qty.

INFORMATION INTEGRATION GROUP
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[tern | 2481-5-50

LA | EACH

Lat Numby{ Show &1 Lots, AL jstibute |

=
1

DESK FILE 51/4" CAP £

2 -10] x|
Bl -

JaM10

B5.00
¥5.00

"""" q | 00

.......

.0a
.0a
.00

Digtribution Balance

Auto Increment 5

2.00

A/lInc. is Auto Increment.
S displays the Shipping screen.

Terms Code
Corfirm Ta
E-mail Addr
Comment

W arehouze

m

T emy Stafford

torysieiaynet. com

ooz

2l

Q

Tracking

FOB

Ship Yia
Ship £one
Ship wWeight
Fraht Ammnt

LIPS BLUE

Q,

ooooo |G Phos

.00

aQ

The Tracking... button opens the Summary Package
Tracking Maintenance screen.

INFORMATION INTEGRATION GROUP
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ﬂm Summary Package

2 -10] x|
=% il

Flg | T| FPackage Tracking, ALT-T

00a1 - #aao

The A button on the Shipping Data Entry screen opens the

Ship To Address screen.

Eﬁ Ship to Address

Ship To
M arne
Address

ZIP Code
City

Country

2l

| QL Residential Add[]

[rvine YW arehouze

86 Technology

Building twa

92818

State

IRIME

LSA

INFORMATION INTEGRATION GROUP
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Packing List Printing

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Packing List or
Both, the Packing List Printing screen is opened when
Accepting Shipping Entry.

ﬂj Packing List Prinking il il

FormCade | STANDA |Gy

Dezcription

Copies 1 j

Multi-Part Farm Enabled[ ]

Print Additional Packing Lists with Contents

Print Camments | Partial |
Charge Itemnsz []

b=gl

bdzg2

Adabe POF hd

[glignment] [ Frink IF"regiewI Setup @

Graphical Crystal printing is available.

If the Addit. Packing Lists box is checked; the
Additional Packing Lists screen is displayed after printing
(or previewing), allowing the user to print the additional
lists.

INFORMATION INTEGRATION GROUP
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Additional Packing List Pri ed
Fom Code | STANDARD |G

Dezcription | (R0l

Copies 'Ilj Collated
Fulti-Part Form Enabled |:|

| #sdiobe PDF =|

[glignment] [ Etint ] Fresvigw lietupl & l

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Invoice or Both, the
S/O Invoice Printing screen is opened when Accepting
Shipping Entry, or after printing Packing List,
correspondingly.

S/0 Invoice Printing ed
Farm | STAMDA |% | Freprinted Lazer |

Copies Collated [v]

Multi-Part Form Enabled [ ]
Comments? m

| ddobe FDF =|

[glignmentl [ Erritit IPFEEiEWI Setup l@l

INFORMATION INTEGRATION GROUP 877.475.4092
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Receipt of Goods Entry

If Batch Entry is allowed in the Purchase Order Options,
the P/O Batch Number screen is displayed before opening
the Receipt of Goods Entry screen.

Ei P/0 Receipt Entry E =10f =]
Batch Ma % 44 b K
Comment [ ]

[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]
Statuz C. By
Entrigz 0 k. By

[ Accept I LCancel I Delete l@]

Click the Next Batch Number button to start a new batch,
or enter an existing batch number.

In this case, the batch number is displayed on the Receipt
of Goods Entry, and can be changed using the Batch
Number button.

INFORMATION INTEGRATION GROUP 877.475.4092
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[F Receipt of Goods E 4 U ] A
Rept | Q[ Batch noooz |

i — | Batches, Al-B |
Date

FO | " v No
Wend Mo, | | ! T

PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch, :
Terms :I 3
| mn Usze Tax |:|

ld 4 & B [gcceptl Cancel I Delete ]

The Receipt of Goods Entry screen enables you to enter

and review receipts of goods.

Enter Receipt Number in the Rcpt No. field or click the #
(Next Number) button to create new receipt.

[fReceipt of Goods E 21 =1 x|

7= Batch |ﬁ|

PO | " Inv.No

"-.J'enl:I.ND.l T o
PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch. :
Terms :I 5
| mﬂ se Tax |:|

I 4 & Bl [gcceptl Cancel I Delete l
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[fReceipt of Goods 21 =1 x|

Reopt 001012 - [0 Bateh 00002 °

Date | 0642372011

PO 0010019 | Inw. Nal 122333

Yend Mo, 01-SLLCLIM |- | DB/A23/200 |

&llclimate Maintenance PO St Mew

Purch. Addr. | W Ck Required | 3/2011 :
Ship To | 0000 C% ABC Distributing Co

T/Sch. | DEFAULT % Default Tax Schedy

Terms QL NET 10

| mﬂ Lse Tax |:|

I 4 & Bl [gcceptl Cancel I Delete l

Y ou can navigate through the orders using standard
navigation arrow buttons at the bottom of the screen.

TheH, A, L, T buttons open Header, Address, Lines,
Totals screens respectively. These screens correspond to
corresponding tabs of the Receipt of Goods Entry screenin
the standard MAS 90.

Here is the Header screen opened with the H button:

2 x]
1099 Form | Here hd

1099 B o x|

Whee | OO0 %

Ship¥ia | 1IPS RED Q,

FOB

Comrment

Confirm | Kirk Taylad

INFORMATION INTEGRATION GROUP
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Click the A button to display the Purchase Address
screen:

[F Purchase Address il |

REUTR il Call
Addrezs | 2331 Trinity Dirive
Suite 1601

ZIP | 92626 State | CA
ity Coszta Meza |
Country | LISA, Ck

Phone | (714] 6661015 00|
Fax | [714) B6E-1000

The Ship To button in this screen opens the Ship To
Address screen:

[ Ship To Address ed

Mame | ABC Distributing Compary
Addresz | 3191 AIRPORT LOOP

ZlF 92626 State | CA
City COSTA MESA

Country | USa |G

The L button on the Receipt of Goods Entry screen
displaysthe Lines screen:

INFORMATION INTEGRATION GROUP
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x

] Do pou want ta receive the
‘--fr) complete purchaze arder?

R
== EER-
[temn Code Elrdered|Fieceived| IJnit Cozt
1001-HOM-H29 500 RO0 34280

[S4BBESON 300 200 545300

2868-3-25 2.00 200 5&75.800
A0 i a0

| | b

LT::-taI.-'i‘-.mDunt| 5,95:3,?5” ok, ]

If an item has Lot/Serial Number, the Lot/Serial
Distribution button allows opening the Lot/Serial No.

Distribution screen:

Enter the lot or serial number for the distribution, or click
the Lookup button to list all available lot numbersto be

distributed.

INFORMATION INTEGRATION GROUP
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[ Lot/Serial Numbe cd U | A

[tern | 2480-8-50 DESK FILE 8" CaF 50

I | CASE J._ . 5':'23 @ - E
Lot Murmber | Ayailable | Drigtribite |
101 97.04
10210 2.00
JaM10 3.25
MaR10 8.80 .on
oo oo
Digtribution Balance .00

mar=e)

At the Distribute field, enter the total lot or serial number
amount to be distributed.

YR P |EEFE -
Eh'= 5 -
[temn Code Elrdered|Fieceived| IJnit Cozt

1001-HOMN-H24  5.00 500 34250
2420-3-50 2.00 200 545300

2PE3-3-25 200 200 &FR.800
GEMDTHA, | 200 200 275850
o a0 .aao

| | b

T atal Amount 251045 (]

For Serial Itemsthe Select Serial Items button is available;

INFORMATION INTEGRATION GROUP 877.475.4092
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2| -10] x|

ltem |GE-MDYE0 | MODEM 3600 [SYMCHR

U/ | EACH = 4=
Select Senal Mumbers, Alt-5 | Lovailable | Diiztribte |

Q) .00

Dhiztribwtion B alance 2.00

ar=e)

Y ou can click the Select Serial Numbers button to salect
the available serial numbers for the item or warehouse to be
distributed.

Y ou can also click the Add Serial Numbers button to
create new serial numbers for items that are being added
back to stock. The Add Serial Numbers task is available
only for seria items.

[F Add Serial Numbers d bl

[tem Code | GB-MD 7RO
YWhee 00

Starting Serial Mo. | SER#O0|

[ oK. ]gan.:e| ]@]

It is necessary to enter only the Starting Serial No. and
sequential Serial numbers are automatically created based
on the Serial Item total quantity received.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM



RF Warehouse Automation 4.40

29

[tern | GE-MDYS0 | MODEM 3600 [SYHCHR

IJsw | EACH % 5':'2@ TG

Serial Mumber | Ayailable | Drigtribite |

SER#001 oo
SER$#002 oo
oo

Digtribution Balance .00

mar=e)

[ Lot/Serial Numbe cd U | A

Y ou can aso add new items directly on the Lines tab of the

Receipt of Goods Entry.

Enter an item number that doesn’t exist in the Inventory

Management.

r%|_Dﬂ s|@ |l |

&
[temn Code Elrdered|Fieceived| IJnit Cozt
1001-HOM-H29 500 RO0 34280

r— —

2480-850 200 200 545300
2568-3-25 200 200 575.800
GE-MD750 200 200 .275.850
ME'_ITEM .00 .00 000

o |

4
Tatal Amt 851045 [ ][ ]| Ok

When pressing Enter, the following message box will
appear asking whether or not to accept the new or Alias

Item.
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[fySage MAS 90

i Iz thiz a new |nventory [tem

Code?

B

Upon clicking Yes, the Item Maintenance screen will
appear for new item entry (Item number is the one entered
on the Lines tab of the Receipt of Goods Entry).

x|

Item | MEW ITEM
Copy From | 1001-HON |G, | EEETIEIES (=

lLr-:u:I Ln wia G WORKSTATION FURI

Fid T | Firished Goot ~|/Wal| FIFD =

P. Code STD QL Froc. Buy -

l‘-.-'v’rnt. Ck

Bt Cst 52,500

StPr 131.000

PrUM [EAC Q, No.of EACH 1

Sls /M| EAC @, No.ofEACH 1

Ftd I1¢m EACH Ck Image | abc_10 Lﬂ ‘

LCaniel

Y ou can use Copy from lookup button to copy the fields of

already existing items for the new one.

After filling in item related information in this screen and
clicking Accept, you will be returned to the Lines tab of

the Receipt of Goods Entry.
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% |oR  s|@| B -

Q EH-E5-
|tern Code I:Irdered|Heceived| it Cost
1001-HOM-H24 500 500 34250
2480850 200 200 545.300
2568325 200 200 575.800
GE-MD7E0 200 200 275850
NEW TH® | 200 200 82500
| i oo 0o

1| | 3
Total Amt 567545 ][] OK

For Alias Items (when you click Alias button on the
message box asking whether or not the entered itemisa
new item), the newly added Alias Item Number
Maintenance screen will be displayed.

[ Alias Item Maintenan

Aliaz lkem Mo

ALlASHO0M

2l xi

Yendar ﬂ
07-ALLCLIM

Type
YWendor

Item Na | 10071-HOM-H252

[tem Description

Aliaz Item Description
ALLCLIM Aliad

HOM 2 DRAWER LETTER FLE /O Lk

o

I

LCancel l

Upon clicking OK you will be returned to the Lines tab
with the selected Item No automatically loaded into the
Item Code field in the data entry.
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2l x|
'“‘*a:-|_D.H 5| @1 e - ‘
QR ER-EB-

[tem Code I:Irdered|Heceived| It Cost
1001-HOW-H29 500 ROD 34.250

2480850 200 300 545300
2RER-3-25 200 200 575800
NEW_ITEM | 200 200 82500
O0THON® | oo o0 3420

| oo 00000

4
Total &mt 512375 [][]| Ok

If the Job Cost (or Work Order) module isintegrated with
Purchase Order, the fields related to Work Order become
availablein the lines grid:

= |mR 2@l B -
Q & -E5-
[tem Code Warehnus&lnst|"-.-'-"u:urk I:Irder|er
K.EYBD-00102 | 000 5 0095015 T

VGAI-42954 | 000 FoDasig |7

4 [ 5
Tokal 2183.00 (]| ok

Enter the Work Order number representing the work order
to which you want to distribute the cost associated with the
line item. Click the Lookup button to list all work order
numbers.

Enter the Step number for the selected work order against
which you want to distribute the cost associated with the
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line item. Click the Lookup button to list all step numbers
for the current work order.

Select a Transaction Type to be used to record the cost of
thelineitem. Thisfield isavailable only if awork order
number or step number was entered

Click the T button on the Receipt of Goods Entry screen
to display the Totals screen:

T axable Purchases a0
Maontaxable Purchases 8.675.45
Freight Amoint | .00
Sales Tax Amount .00
Irwaoice Tatal 2.675.45
Prepayment &xvailable .00
Frepayment Applied .00
Prepaid Check Mumber

Hold Paprnent []

[I__anl:led I:Dst...| Tay Detail... l
| Add Totals | 0K |

N/Tax. stands for Non-Taxable,
S/Tax for Sales Tax,

P/Pmnt Prepayment,

and P/Paid for Prepaid.

Hld Pmnt stands for Hold Payment.

The Landed Cost button opens the Landed Cost Entry
screen:
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e T
ok T_I,Ip{:u:rip|1eth Arnount |
FRGHT Frei 25.00
2 0

Total Landed Cost Z5.00

[ 1] l LCancel L

The Add. Totals... button in the Totals screen opens the
Totals Additional screen:

Em Totals Additional ilil
CODNumber | |

Lesz COD Amaunt .00 |
COD Check Ma
[rvoice B alance 612375 |

Inwoice Due Date | OF /0420011
Digcount 0 ate 070442011

Digount Amoint 2.00
Frepaid Freight 20.00

Bank Code ' - Security Pacific Checki
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'“?2:-|Q_H s @[ B - ‘
| QA EREES-

Iterm Code Drdered|F|eu:eived| it Cost
1001HONHZ| 500 500 34.250
2480-8-50 300 200 545300
2568325 200 200 575300
MEW ITEM | 200 200 82500 ++NEW++ and ++AUTO++
1001-HONHZ] .00 00 34250
a0 00 000
| | k)l

Tatal At E.123.75 | I Ok

RFS Receipt of Goods works with bar code scanners.

If the New box is checked, the program will add itemsin
new lines irrespective of their presence in the existing lines.

If the Auto Increment box is cleared, the program will find
line with this item and select that line. Y ou can increase the
quantity in the line manually.

If the Auto Increment box is checked, the program will
automatically increase the quantity of the item in the line
where the received quantity does not exceed the ordered. A
new line will be added only if there is no such line.

Y ou can either check these boxes with the mouse or type in
++NEW++ or ++AUTO++ respectively in the Item

Number field.
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|nventory Transaction Entry

The Inventory Transaction Entry screen allows entering
Transactions of the Transfer and Adjustment types.

2| =101 x|

Tranzaction Type | INEGEEE

| |
Entry Murnber %

Tranzaction Date

Tranzfer From "Warehouse

Transfer To %W arehouze
Comrment

Linesz

4 4 F K [ECDEPt I Eancell Qeletel

Select Transfers in the Transaction Type drop-down list
and click the Next Entry Number button.
Enter the Transfer Date, Transfer From and To

Warehouses, and Comment.

Tranzaction Type | Transfers |
Enty Mumber 00000009 [

Tranzaction Date | 06/25/2011 :
Tranzfer From Warehouze | 000 Ck
CEMTRAL WAREHOLUSE

Tranzfer ToWarehouse ooz Ck

WEST wWaREHOUSE
Comrment

Lines

4 4 @ W [ECDEPt I Eancell Qeletel
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Y ou can navigate through the Transactions using standard
navigation arrow buttons at the bottom of the screen.
Click the Lines button to open the Transaction Lines
screen.

x|
Y |er[ @@

I —
|EB B! =B

[tem Code To'whae | Fran
2480-8-50 IJEIE &, | 000
2
1| | r

Select an Item or its General Alias. The To Warehouse is
defaulted from the header and may be changed for
particular line. Enter the Quantity to be transferred, and
click OK.

If theitem is Lot/Serial, the Lot/Serial Distribution screen
IS popup.
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[ Lot/Serial Numb cd U | A
[tern | 2480-8-50 DESK FILE &' CaP &0
A | EACH J._ | 5':'33 @ - &
Lat Numl:uer| .ﬁ.vailal:ule| Distribute |
1 101 9.702.00 2.00
R
3| JaM10 323.00 2.00
4 | MaR10 850,00 0o
] 0o 0o
Diztribution Balance 0o
)

Enter Lot(Serial) Number, and quantity to Distribute.
The List button opensthe list of all the Lot(Seria)
numbers. Use the & button to distribute all the quantity to a

selected Lot Number.

Select Adjustments in the Transaction Type drop-down
list and click the Next Entry Number button.
Enter the Transaction Date, Default Warehouse, and

Comment.

[F Transaction Entr

Trangaction Type | Adjustments

Entry Hurmber Qo000

Tranzachon Date | 0642942011

Drefault ‘W arehouze Qoo
CEMTRAL wWaREHOUSE

Comment

Lines

2l =101 %]
O

E

a

14 4 b bi [2eospt] Cancel| Deere |
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Click the Lines button to open the Transaction Lines
screen.

[if Transaction Lines X

2480-3-50 T, Lot Mo
DESE FILE 8" CAF &0
114 YWhee [luantiby
EACH 000 T
IInit Cozt E stenzion
15.656 1.3
2480-8-50
EACH 000 [.000
1001-HOM-H252
EACH 000 2.000 33500

e

For items with LIFO/FIFO Vauation, the distribution
screen is displayed on entering the quantity.

[ Distribution Entry g
[kem | 1007 -HOM-H2540LE.
Unit of Measure | EACH

FIFO Drate 0341542010

Receipt Mo, | BC-0707
Ay ailable 10.00
Diiztribute 7

Distribution Balance 00

For items with Lot/Serial Valuation, the distribution screen
is displayed on entering the quantity.
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[\ Distribution Entry ed
[tern | 2481-5-50
Init of Meazure | EACH

Lot Murnber
kR0

A ailable 325.00
Diistribute a7

Digtribution Balance .00

Physical Count Entry

On the Physical Count Entry screen, enter the Warehouse
Code, and make selections by Bin Location, Item

Number and Product Line.

ﬂj Physical Count E il ;lglil
‘Warehouse (000 | - I 4 B B
CEMTRAL WaREHOUSE

[Su:-rt Linez By | Item Code ﬂ ]
~—Selections

Select Figld | Operand | Wally =~ |
ltem Code Al L+

Bin Location Al =]
[tern Descripti Al j
[vertam Cyc All -

Drercdiimk | i Al - | il
A | b

[ Lines ”gccept I Eancell

Y ou can navigate through the Warehouses using standard
navigation arrow buttons at the bottom of the screen.

Click the Lines button to open the Physical Count Lines

screen.
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r|_D_uiu:th:uw | |=' = |

[tem Code
[10071-HON-H252 Q

Bin Location

[term Code Bin Location
1 E-300-10

4| | b
Auta ncr.

The Lookup button opens the Item List screen.

2 (5]
Itern Code / o

e AT g
1007-HON-H252LK HON 2 DR&WE|_
1001-HON-H254 HON 4 DR&WE
1001 -HON-H254LK HON 4 DR&WE
2480850 DESK FILE 8" C.
2481550 DESK FILE 51/
2551-3-60 DESK FILE 31/,
2568-3-25 DESK FILE 31/,
4806-18-14-3 PAPER CADDY
BES0-26-16-11 SOUND CVR 26
BE52-26-24-15 SOUND CVR 25
BES5 PRINTER STAN
6657-24-20-12 SOUND CVR 24
8953 UNIVERSAL 317
1| | 3

leIt...“j Search [ ViEWSlﬁelect]Eancell

| Found 80 rec | | |

Item Bin Location will be displayed for the selected item.
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[ Physical Count Lines ed ot
r|_|]_uiu:k Raow | |§:ﬂ T [
[tem Code
1001-HON-H252 1SN
Bin Location
[tern Code Counted
10071 -HOM-H252
’ [»
Auto [ner.

If the Auto Incr. box is cleared, the program will find the
item and select that line. Y ou can increase the count

manually.

If the Auto Increment box is checked, the program will
automatically count up the item just after entering/scanning

the Item Number.

Y ou can enter/select the Item number or its General Alias.
If the selected Item is Lot/Serial, all the Lots (Serials) of

theitem are listed.

Select alot item from the Item List.

r|_D~ui|:k Fiow | |?¢.¢ - 1
Itern Code
| 2430-8-50 =N
Bin Location | C-100-10
Lot Number | 101 |
Itern Code Courted I;
1| 1001-HON-H252 2100
R =020 | o
3 | 2480-5-50 00 —
4 | 2420-8-50 0o
1 | » |_I
Auto Inor.
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Enter lot number in the Lot Number field and click Enter.
If the entered Lot Number existsin thelist it will be
selected, otherwise new Lot Number will be added in the
list.

Ej Physical Count Lines 2 x|

| Buick Row IREE
[tem Code
2480-3-50 Q,
Bin Location | C-100-10
Lot Murnber :
[tern Code Counted | =
1 | 1001-HOW-HZ52 2.00
2 | 24B0-8-50 1.00
3 | 2480-8-50 a0
F 2e0e50  (NNRGEN .
1 | » |_I
Auto Irer.

If the Auto Incr. box is cleared, the Lot number with O
count will be added. Y ou can increase the count manually.
If the Auto Increment box is checked, the program will
automatically increase the count of thelot.

Enter ++Auto++ in the Item Codeor Lot Number fields
and press Enter to check/uncheck the Auto Incr. box
automatically.

[fPhysical Count Lines 2|

Bin Location ke Murmber 1k

C-1o010 2430-8-50 % EACH
DESE. FILE 8" CAP 50

Lot Mumber Count
++AUT0+ 0.00

C-10040

FEB1O EACH 1.00
Jar1n EACH 2.00
E-300-10 1001-HOM-H252
EACH 0.00
Auto lner. [ ] [al's
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Lookupsin RFS

Lookups in the RFS enhancement enable all the
functionality the standard MAS 90 lookups have (except
for the Zoom button). The starting symbols can be entered
before clicking the Lookup button to narrow the displayed

itemslist.

[ Item Lisk

|tem Code
1001-HOM-H

1001-HOMN-H252LK

1001-HOM-H254

1001-HOMN-H284LK

2480-8-50
2431-5-50
2651-3-50
20k8-3-25
4386-15-14-3
BE50-26-16-11
BEBZ2-28-24-15
BEEE
BES/-24-20-12
8353

4
[Fit..| (] Search [] views

HOM 4 DRAWEI
HOM 4 DRAWEI
DESE FILE 8" C
DESE FILE 51/
DESKE FILE 31/
DESKE FILE 31/
FAPER CADDY
SOUMD CVR 26
SOUMD CVR 28
PRIMTER STAN
SOUMND CVR 24

UNIVEHSﬁLiﬂ
3

| Select | LCancel

| Found 80 rec |

TheFilt... button enables setting Filters.

/5
Calurn | Operand | Yalue |

1 [kem EDdEJ

=

* | Begins jEdE

=

Save Filers ||

After applying thefilters, the Filt... button appears red.
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711

|tem Ciod /| Description

24 1]
2481-5-60

J | i
[Fjlt...] [] Search[ ] "v"iEWS| Select |§ancel
|F|:|ur'u:| 2 rect | | |

Check the Search box to specify search criteriain the
displayed fields. Click Find to search with the entered

criteria.

EIpI=ES
|tem Code i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DR&WE
1001-HOM-H252LE. HOM 2 DRAWEI
1001-HOM-H254 HOM 4 DRAWEI
1001-HOM-H254LE. HOM 4 DRAWE]
2480-8-50 DESKE FILE 8"
2481580 DESE FILER 14
2501-3-60 DESE FILE 314
2A68-3-25 DESE FILE 314
4886-18-14-3 FAFER CADDY =
1 | | 3
Itern Code ﬂ B eginz with ﬂ

25

Find
Filt... Search | | | Select |§ancel

|F|:|ur'u:| 20 rec | | |

Check the Views box to work with lookup views.

Select aview from the View drop-down box to switch to

that view.
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[ * Item List I ]
|tem Caode i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DRAWE
1001-HOM-H252LE. HOM 2 DR&WE]
1001-HOM-H254 HOM 4 DR&WE]
1001-HOMN-H254LE. HOM 4 DRAWEI
2480-8-50 DESE FILE 8"
2481580 DESEFILER 14
2551-3-60 DESK FILE 314
28R8-3-25 DESE FILE 314
4386-18-14-3 PAPER CADDY =
4 I I ]
Wiew “Brief hd

“Birief
|Fj|t... [] ViEWSl Select |Eancel

|F|:|ur'u:| a0 rec | | |

If there is no custom view, the View drop-down box is not

visible.

EIpI=ES
|tem Code i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DR&WE
1001-HOM-H252LE. HOM 2 DRAWEI
1001-HOM-H254 HOM 4 DRAWEI
1001-HOM-H254LE. HOM 4 DRAWE]
2480-8-50 DESKE FILE 8"
2481580 DESE FILER 14
2501-3-60 DESE FILE 314
2A68-3-25 DESE FILE 314
4886-18-14-3 FAFER CADDY =
1 | | 3
|F.i|'i--- [ ] UlEWSl Select |§ancel
|F|:|ur'u:| 3 rec | | |

Click Cust... button to create a new or change an existing

view.
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ﬂ& Lookup Customization i' il

Select view parameters for Lookup.
Company ABC, Uzer G

Wiew | Create new wiew ﬂ|

D escription | |
Default Wiew

[ Delete l l Mest » l I LCancel l

Select or modify the colurmls).
Company &BC, Uzer IG Yiew - Brief

Available Fields Selected Columnz

- StandardUriit] = | @ * |tern Cade

- Standardl mitF Description

: WarrantyCode
- LastT atalllnitl
ast oAl @ StandardUnit0 de:
- BeragellmitC

; TarClazs
- S alesPramotic

- Suggested e
- SalezPromotic

- Totalluantityl @
- AvaraneR ark

i O e

[NewFisid..| 7= |{= ][ bodiv. |

[ <Back |[ mest> |[ Finish |
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Heading |
Width ]
Justification
Mask L HEE A HHO00-
Caleul field | &1

ok LCancel

ﬂm, Calculated Field Bui

nnaann
Available Fields
Itemlmage'w'inﬂ
ltemlmageHe
i StandardUritl

- StandardUrni
- LastTotalUnit »

| »

[ﬂ] [ ok ] [Eancell
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[F Lookup Customizatio ed
Enter ar modify the filkerlz].
Company &BC, Uzer IG Yiew - Brief

Calurnn

1
2

[ 44

1| | *
[ < Back |[ Wewt> ][ Einish |
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Appendix

An example of RFS Installation on handheld devices

1-Microsoft Active Sync should be installed on the computer:

1-Download:
http://www.microsoft.com/downloads/details.aspx?FamilylD=7269173A-28BF-
4CAC-A682-58D3233EFB4C&displaylang=en
(If thislink didn’t work easily open www.google.com and search for “Download
Microsoft Active Sync”)
2-Click on Run

File Download - Security Warning

Do you want to run or save this file?

Mame: setup.exe
Tupe: Application, &,93MB

From: download.microsoft,com

Run J [ Save ] [ Cancel

i | While files fram the Intermet can be uzeful, thiz file twpe can
I L’j potentially harm your computer. IF pou do not trust the source, do not
= run o gave this software. What's the rigk?

3-On Welcome Page Click Next
4-Accept License Agreement and click next
5-Enter Customer Information and click next
6-Choose Destination folder and click next
7-Install...

8-Finish

2-After Installation of Microsoft Active Sync connect your PDA to the computer using
USB Cable and select Guest Partnership (No) and click next.
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Mew Partnership

Set Up a Partnership

Befare vou can synchronize information between pour
mobile device and thiz computer, you must zet up a
partnership between them.

Wiould you like bo zet up a partnerzhip?

O ves

Set up a partherzhip 2o that | can synchronize
infarmation between my device and this compker.

| don't want to synchronize infarmation. Set up my
device az a guest zo that | can copy or move
infarmation between my device and this complker.

< Back L_ﬂe:-cb ][ Cancel ] [ Help ]

3- In order to make connection between handheld device and Citrix server, Citrix ICA
client for windows CE has to be installed on PDA:

1-Download Citrix ICA client for Windows CE on your computer:
http://www.citrix.com/site/SS/downloads/details.asp?dID=2755&downloadID=3602
(If thislink didn’t work easily open www.google.com and search for “Citrix ICA client
for windows CE")

2-Installation:
1-Run cesetup.exe
2-1t will ask for installation path:

Installing Applications El

Inskall "Cikrix Systems ICA Client” using the default application install directary

Cancel |

3-Click on “No” button
4-following screen will pop up:
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x|

Save ln: b ain b emary j
kd ain b emary
| Platform
Space regui

JApplication

Space availab

k. I Cancel

1=

Choose “Application” option from drop down list and click “OK” and follow the
installation on PDA screen to complete the installation. It will add two icons on PDA’s
Programs screen:

5-finish

4- Configuration of RFS on Handheld Device:
1-On handheld Device Click on Start then Programs
2-Choose ICA Client

l.;'E.wir ' Programs o3 oz 3216 9
Adr [ -
BEAM I
Games AirBEAM Calculator
Client

» [3

File Explorer ICA Client UT  p{f:N N (<]

Settings
wis
r & P
Microsoft SN Pictures

Reader Messenger —
% ¥ ®

Pocket Excel Pocket MSN Pocket —
Word i

E|A
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3-Create New Connection

£ Internet Explorer  +F < 3:16 9

L)

bttp:ff127.0.0, 1fmain.htm -| @
E Main

Create Mew Connection
Pl Agent Properties
Edit Global Settings

| Connect | | Edit | | Delete
Bbout Citrix (8 Client For Mindows CE

view Tools ¢ £ (3 <% E|A

4-Enter the Citrix Server |P address

l.;'E;" Internet Explorer 4 =2 3:43 9

http:ff127.0.0.1fserver htmPvCreat - | @
E Main = Mew Connection > Server

Settings
Server or Published Application:
192,168,111.120

Refresh Servers
Refresh Published Applications
Server Locakion

| Save | |Eancel|

view Tools ¢ € o <% E|*
5-Save
6-Edit

877.475.4092
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7-Edit Application Settings

.,F.F Internet Explorer 4 =42 3:53 9

http:/f127.0.0.1{application.htrmay - = | @

|E| Main = Edit 192,165.111,120

Settings = Application Settings

Application:

Working Directary:

| Save | |Eanl:el|

view Tools ¢ £ (3 <% E|A

8-1n this step you need to know the MAS 90/200 running address on Citrix Server. So,
Login to the CITRIX Server and Right-click on the MAS 90/200 program Shortcut and
select properties then write down the Address in Start-in path.

According to Shortcut address on Citrix Server fill the Application and working
Directory fields:

Application: your path\M A S90\Home\pvxwin32.exe -hd ..\launcher\sota.ini
.\s0a\RFS_Startup.mdp

Working Directory: your path\MAS90\Home

(Where your path stays for the path to your MAS 90/200 Start-in path, e.g.
D:\MAS\MasA410\Rfs).

10-Save
11-Click on Edit link and click on Edit Logon Information.
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*,frwj Internet Explorer 4 {2 4:10 9

http:ff127.0.0.1{login.htrm?vbame « [ @

E Main = Edit 192.165.111.120

Settings = Logon Information

Username:

Password;

Darnain:

| Save | |Eanl:el|

Yiew Tools <@ @ < E|*

12-Enter your Citrix server logon Username, Password and Domain and saveit.

13-Click on “Edit <citrix server |P address> Settings’ link and click on “Edit Windows

Settings”

i o i LA
1 £ -
l.,Ej Internet Explorer on ={£ 4:14 9

http:ff127.0.0.1fwindow hitm?vMa - - | @

e
|z| Main

= Edit 192.168,111,120 Settings
= Window Settings (Absolute Size in
Pixels)

Window Colars:

Zhange ko Fit to -
Screen

Initial Displaw Scale Factor:

Initial Panning Position:
Ton | oft

¥iew Tools <3 ‘é T E|A

-

14- Click on “Changeto Fit to Screen” link and saveit.
15- Finish
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Sample
For the setup of Symbol MC9090 handhelds

AD Prep and Documentation

Allocate the handheld’s IP address, HH username, and hostname. Place adhesive labels
on the handheld using the format “HH<##> <hostname> <IP address>".
Update info on the Handheld IP’s Excel Spreadsheet.

Initial Handheld Setup

1. Immediately place the unit in the charger to ensure the backup battery becomes fully
charged. Once the handheld is charged, proceed to the next step, removing the
handheld from the charging unit. (Charging will be more rapid if the handheld unit
remains powered off.)

2. Click on the Start button and set the system time.

3. Enter the hostname of the handheld and its description.

e Go to Start > Settings > System tab > About > Device ID tab > Device name:

e (In the Description field, input the HH user who will be using the handheld.)

e Click OK to exit.

4. From the main screen, disable 802.11d wireless access by using the Wireless Options
tool.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Regulatory”, then clear the “Enable
802.11d"” checkbox.

e Click Save to save changes, then Exit.

5. For P3 handhelds only — Enable both 2.4 GHz and 5.0 GHz bands for wireless
connectivity.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Band Selection” and ensure that both “2.4
GHZ Band” and “5 GHz Band” are selected.

e Click Save to save changes, then Exit.

6. Connect the handheld to your company wireless network

e Select the wireless icon on the lower right of the screen, and then select “Find
WLANSs" from the pop-up menu.

e Once the scan for WLANSs has finished, select and hold your stylus over the
“yournetworkname” WLAN, then select Connect to initiate the connection
wizard. Enter the following settings:

0 Profile ID — accept both defaults, which should be “yournetworkname”.
Click Next to continue.

0 Operating Mode — accept both defaults, which should be
“Infrastructure” and “Allow Any Country”. Click Next.
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o

Authentication — accept default “none”. Click Next.

0 Encryption — use the drop-down menu to select “40-Bit WEP”. Accept
the default Key Index of 1 and leave the “Use Passkey” checkbox
unchecked. Click Next.

O 40-Bit WEP —replace the password fields with 10 lowercase a’s: aaaaa
aaaaa. Click Next.

0 IP Address Entry — Use the drop-down menu to change the option to
“Static”. Click Next. Enter the IP Address and Subnet Mask, then check
the Advanced check box. Click Next. Leave the G/W field blank, enter
DNS server info, and leave the WINS field blank. Click Next.

0 On all remaining screens, accept all defaults. You will then be back at
the Manage Profiles screen. Click OK to exit.

0 If you are prompted with a pop up box that says “Establishing
Connection”, choose the “Work” connection.

0 On the lower right corner of your screen, you should see your wireless

status indicator either in red, yellow, or green, indicating the strength of

your wireless signal.

7. Test connectivity to your LAN.

e Click on the wireless status icon in the lower right corner of your screen and
select “Wireless Diagnostics” from the popup menu.

e Select ICMP Ping.

e Inthe IP field, enter 172.16.1.1, and click on Start Test.

e Monitor the Total Tx and Total Rx indicators to ensure you are able to ping the
company gateway.

Installing The Datawedge Application

1.

Place the handheld in a charger and connect the charger via a USB cable to a computer
that has Microsoft ActiveSync installed.
Upon your computer’s registering the connected mobile device, navigate through the
Active Sync wizard, indicating that there is nothing you want to synchronize. If your
system does not connect to the handheld, try adjust the “USB to PC” setting on the
handheld. By default the “Enable advanced network functionality” checkbox is checked.
You should uncheck it if you experience any connectivity issues.
e Go to Start > Settings > Connections tab > USB to PC
Go to your computer, and select the “Explore PocketPC” option from the Tools menu of
Active Sync. This will open an Explorer window into your handheld.
Copy the appropriate Datawedge components, as excerpted below from Symbol’s
documentation:
e Unzip the DataWedge download package (if necessary) into a temporary folder
on the PC.
e Copy “\Bin\PPC\DataWedge.exe” from the PC to the \Application folder on the
device.
e Copy “\Application\DataWedge.cpy” from your PC to the \Application folder on
the device.
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8.
9.

Browse to the \Application\Bin\PPC\DataWedge.exe file, hold the stylus on the file until
the popup menu appears, and select Copy.

Paste the shortcut into the Windows\Startup folder on the handheld. (If you cannot see
the Windows folder, you may need to enable the option to unhide hidden and system
files on your computer.) Then manually launch Datawedge by selecting it while you are
still in the \Windows\Startup folder.

Click on the DataWedge icon in the lower right corner of your screen, and from the
popup menus, go to Barcode > Prefix/Suffix.

Check the checkbox that says “Send ENTER key after suffix”

Click OK to exit.

10. Test the scanner by opening Word Mobile and performing a test scan.

e Go to Start > Programs > Word Mobile

e Click on New to create a new document if no other test document is available.

e Scan a barcode and observe the data in Word Mobile. Each successive scan
should be on its own line.

e Exit until you get the handheld’s main screen.

Installing the Citrix ICA Client

1.

From your computer make sure that the handheld has been able to reconnect to your
computer, and run the Citrix CE client program, cesetup.exe. Click OK when prompted.
Your computer will now display a message stating that you should check the handheld
for any further messages to finish this installation. Click OK and proceed to your
handheld...

Your handheld should now be asking you a location to which you want to install the
Citrix client. Accept the default, which should be “Device”, then click “Install” on the
lower left corner of your screen.

Click on “I Accept” to accept the license agreement.

After the program installs, you will receive a confirmation message that installation was
successful. Click OK to exit.

Warm boot the handheld to verify that DataWedge loads on startup.

Disconnect the handheld from the cradle and terminate your Active Sync session, as
wireless access may be disabled while connected to Active Sync.

Connection Settings For Wireless Citrix Environment

1.

v wnN

Open the Citrix ICA client configuration utility.

e Go to Start > Programs > ICA Client
From the main menu, select PN Agent Properties.
Select “Enable PN Agent”.
In the Server URL field, enter the IP address 172.16.1.195, then click on the Save button.
If the connection is made, you will be presented with a Login Details screen. Enter the
below details:

e Username: the HH<##> ID of the handheld.

e Password: the default password.

e Domain: “your domain name”
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Check the “Save Password” checkbox, and then click OK.

When the screen refreshes, scroll down and click on the Save button one more time.
At the top of that screen, click on the “Main” hyperlink.

Click on Edit Global Settings.

. Click on Edit Preferences.

. Scroll down to the “Enable Full Screen (No Local Taskbar)” checkbox, and check it.

. Scroll to the bottom of the screen, and click Save.

. Click the X to exit.

. You should now be at the Programs Screen. Click the X to exit to the Main screen of the

handheld.

Setting up a Connection to MAS

1.

ouhkwnN

Notes

1.

Configure the appropriate menu settings.

e Go to Start > Settings > Personal tab > Menus

Scroll down the Menus page until you see the “T200” icon, and select it. Click OK to exit.
The T200 icon should now appear on the Start Menu.

Click on the T200 icon to initiate a connection to MAS.

Enter the appropriate User ID and corresponding password.

If this is the first time you have connected to MAS using this handheld, MAS will prompt
you for the company code you wish to access. Enter TGL and select OK.

You should now be at the MAS 90 for Win CE main menu. Select Shut Down to exit
MAS. You will be returned to the handheld’s main screen.

In the event that the handheld is cold booted, most (if not all) of the setup steps will
need to be repeated. A warm boot will cause no loss of settings.

When resetting after a cold boot, make sure to rename the handheld to the
appropriate hostname BEFORE configuring the Citrix environment. This will aid
in not causing duplicate terminal server licenses from being issues to the same
handheld. Also make sure the handheld is not connected to Active Sync.
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